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 Enclosure 5 
 
 
Procedure for Completing the HCBS Waiver Plan of Treatment (POT) 
 
The HCBS POT is a Word-based document that can be filled out either electronically or 
manually.  A copy of the In-Home Operations (IHO) POT is available at: 
http://www.dhcs.ca.gov/formsandpubs/publications/Documents/IHO-HCBS%20POTdoc-
5A.pdf  IHO has enclosed a manual version of the POT in this WPCS Request Packet.  
(Enclosure 5A) 
 
This POT can be used for Medi-Cal participants receiving services through one of the 
HCBS Waivers administered by IHO and/or Private Duty Nursing (PDN) services 
through the Medi-Cal Early and Periodic Screening, Diagnosis, and Treatment (EPSDT) 
Benefit.  Below are general directions for completing each section of the form. 
 
The Comments Section may be used throughout the document to provide explanatory 
information as necessary.  The completed POT must contain original signatures from the 
participant and/or the legal representative, Primary Care Physician, and for HCBS 
Waiver participants, each HCBS Waiver service provider, i.e., primary caregiver, home 
health agency (HHA), or Individual Nurse Provider (INP), or for EPSDT participants, 
each INP.  Once all signatures have been obtained, keep the original and return a signed 
copy of the POT to the appropriate IHO Regional Office. 
 
Step 1:  (For the Electronic POT only) 
(Note:  For the manual version go to Step 2) 
 
1. Unlock the document; 
2. Go to the View menu; 
3. Click on Toolbars; 
4. Click on Forms; 

(A √ should appear next to Forms.  The Forms toolbar will appear with the LOCK 
button turned on.  In the “Locked” mode, the button will have a light gray 
background.) 

5. Click on the LOCK button.  In the “Unlocked” mode the button will have a 
medium gray background; and, 

6. Complete the header at the top of Page 2 by entering the “Participant’s Name” 
and the Treatment Period “From” and “To” dates. 

 
How to access the header (2 methods): 
 
Method A:  Go to Page 2.  Using your mouse, double-click on the header and enter the 
information.  To exit this function using your mouse, double-click on any area outside of 
the header.  This information will then auto-fill on the subsequent pages. 
 
or
 
Method B:  Go to the View menu, click on Header and Footer and scroll down to Page 2.  
Enter the information in the Header.  To exit this function, go back to the menu bar, click 
on View, and click on the √ next to Header and Footer. 

http://www.dhcs.ca.gov/formsandpubs/publications/Documents/IHO-HCBS%20POTdoc-5A.pdf
http://www.dhcs.ca.gov/formsandpubs/publications/Documents/IHO-HCBS%20POTdoc-5A.pdf
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To Lock the document, click on the LOCK button.  The button background will change 
to light gray. 
 
Complete the POT as instructed below in Step 3. 
 
Helpful hints for using the electronic version. 
 
• This document has been developed with check boxes, drop-down menus, and 

locked fields. 
• Do not use the ENTER/RETURN key, as it will alter the formatting and 

disrupt the spacing throughout the document. 
• Check boxes.  The check box can be marked with an “X” by placing the cursor 

over the box and using the mouse to single-click on it. 
• Drop-down menus.  The drop-down menu can be accessed by: 

• placing the cursor over the box; 
• single-clicking it with the mouse; and, 
• selecting the appropriate response.   

 
The only drop-down menus present on the POT are found in Section 7, entitled  
“Waiver-Specific Services”. 
 
Locked fields.  The locked fields appear as gray-shaded areas and are preset so the 
user can tab through the document from one field to the next.  You can also use your 
mouse to maneuver around the document. 
 
Be sure that the Lock button is turned “ON”.  If the Lock button is turned off prior to 
completion, the form will not work properly. 
 
Spell Check.  In order to spell check the document, the POT must be entirely completed 
and the Lock button must be turned “Off".  Go to the Tools drop-down menu and click 
on Spelling and Grammar.  Once the spell check is complete, you can save the 
document by going to the File drop-down menu and clicking on Save As. 
 

 IMPORTANT:  If the Lock button is turned back “ON” after any information has been 
entered on the POT, it will delete all of the information you have entered on the POT. 

 
 
Step 2:  (For the Manual POT only) 
 
On Pages 2 through 14, complete the header by entering the “Participant’s Name” and 
the Treatment Period “From” and “To” dates.  Then complete the POT as instructed 
below in Step 3. 
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Step 3:  Completing the HCBS POT (for both the Electronic and Manual POTs) 
 
Section 1:  Participant Information 
 
Please complete as indicated.  The medical record number of the participant is 
optional and is used for the provider’s filing purposes.  The primary language may 
include the primary caregiver’s primary language, if different from that of the participant. 
 
Section 2:  HCBS Provider Information 
 
Please complete as indicated.  The “Provider Name” should be the name of the HHA or 
individual who is primarily responsible for the services described on the POT.  This 
would include the HHA, Case Manager (CM), Professional Corporation (PC), or the lead 
Individual Nurse Provider (INP) L.V.N. for participants receiving EPSDT Private Duty 
Nursing (PDN) services without R.N. Case Management.  The “Treatment Period” may 
vary depending upon the licensure and/or certification requirements of the provider. 
 
Section 3:  Primary Care Physician 
 
Please complete as indicated.  The Primary Care Physician should be the physician 
signing the POT. 
 
Section 4:  Medical Information 
 
Please complete as indicated.  Include all ICD-9 codes or diagnosis codes where 
appropriate.  The “Other” section may be used, if there are other diagnoses pertaining 
to the participant.  You may contact the M.D. (Primary Care Physician) to obtain the 
diagnosis and ICD-9 codes.  For the prognosis, please check only one of the boxes 
provided for you, i.e., excellent, good, fair, or poor. 
 
Section 5:  Medi-Cal Home- and Community-Based Services Program 
 
Please check all of the appropriate programs for which services are being requested.  
You may contact your assigned IHO Nurse Case Manager for the appropriate program 
information. 
 
Section 6:  Level of Care (LOC) 
 
The level-of-care determination will be made by the Medi-Cal In-Home Operations 
Branch and given to the provider (HHA, CM, PC, or INP).  Please check only one 
box—once a determination has been provided. 
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Section 7:  Waiver-Specific Services 
 
Note: Do not complete this section for participants receiving only EPSDT PDN 

services. 
 
Please complete as indicated.  All of the “Waiver-Specific Services” are listed in this 
section.  Please check all of the services the participant is utilizing.  If you are using the 
document electronically, please click on the arrow under the Frequency Key Code, and 
double-click on the appropriate Key Code.  If “Other” is used, then please describe. 
 
Section 8:  Non-Waiver Services 
 
For participants enrolled in one of the HCBS Waivers, federal regulations require that all 
non-waiver services the participant is receiving be described on the POT.  The 
description of the services should include the amount, frequency, and the provider(s) of 
services.  Non-waiver services may include services funded by Medi-Cal, Regional 
Centers, California Children’s Services, Independent Living Centers, In-Home 
Supportive Services, Department of Rehabilitation, Department of Mental Health, 
Private Insurance, and/or school-based services (i.e., Adult Day Health Care (ADHC), 
Pediatric Day Health Care (PDHC), Social Services Referrals, Medical Therapy 
Program, Housing Referrals, Respite, and Vocational Rehabilitation). 
 
Section 9:  Nutritional Requirements 
 
Please describe any nutritional requirements for the participant, as ordered by the 
physician.  Please indicate the type of diet, method of feeding, amount, and frequency. 
 
Section 10:  Medication Plan for Home Program 
 
Please complete as indicated.  This includes prescription and nonprescription medications.   
 
Section 11:  Treatment Plan for Home Program 
 
M.D. orders must identify all services rendered by the provider.  Please list/describe all 
services provided, including the: 
• provider(s) of service(s); 
• provider type(s); 
• amount and frequency of services; and, 
• type(s) of service(s) provided. 
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Section 12:  Functional Limitations 
 
Please describe functional limitations, per the physician’s order, within each category. 
If “no” limitations are noted, please check the appropriate box and proceed to Section 13. 
 
MOTOR  (i.e., amputation, contracture, paralysis, ambulation, partial weight bearing, 
cane, crutches, wheelchair, or walker) 
 
SELF-HELP  (i.e., incontinent of bowel/bladder or independent at home) 
 
COMMUNICATION/SENSORY  (i.e., hearing, speech, legal blindness, or glasses) 
 
Section 13:  Activities 
 
Please describe all activities performed by the participant, as per the physician’s order 
(i.e., endurance, dyspnea with exertion, complete bed rest, bed rest with BRP, up as 
tolerated, or exercises prescribed).  If “no” restrictions on activities are noted, please 
check the appropriate box and proceed to Section 14. 
 
Section 14:  Mental Status  
 
Please summarize the mental status of the participant (i.e., comatose, forgetful, 
depressed, disoriented, lethargic, agitated, or developmentally delayed).  If “no” 
limitations are noted, please check the appropriate box and proceed to Section 15. 
 
Section 15: Durable Medical Equipment  
 
Please list all types of equipment used, providers of equipment, and funding sources, 
such as Medi-Cal, private insurance, or Medicare, if known. 
 
Section 16:  Medical Supplies  
 
Please list all types of supplies used, providers of supplies, and funding sources, such 
as Medi-Cal, private insurance, or Medicare, if known. 
 
Section 17:  Therapies/Referrals  
 
Please check all types of therapy that apply, provide the date each referral was made, 
and the reason(s) why the referral was made.  If therapy is ongoing, please indicate 
the current progress/status in Section 20.  If the type of therapy is not listed, please 
use the “Other/List”. 
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Section 18:  Treatment Goals/Discharge Plans  
 
Please check the appropriate box.  If you select the second box, you must describe the 
level of support needed, i.e., minimal, moderate, or maximum. 
 
Describe specific goals and discharge plans as identified on the POT, i.e., participant 
will be able to self-direct caregivers in trach care, primary caregivers will be 
knowledgeable in diabetic management, or primary caregivers will be knowledgeable in 
pressure relief. 
 
Section 19:  Training Needs for the Participant/Family  
 
Please check only one box for training needs.  If you choose “yes”, please use the area 
provided to describe the training needs of the participant/family and list the name(s) of 
the provider(s). 
 
Section 20:  Summary of Participant’s Status During This Treatment Period 
 
Please summarize the status of the participant during the treatment period for this 
POT.  This area may also be used, as stated in Section 17, to describe the current 
progress/status of ongoing therapy.  Each INP is to provide a summary of the care 
he/she provided and the overall status of the participant, including the participant’s 
response to the POT and any significant changes. 
 
Signature Section  
 
Please complete the POT Form and obtain original signatures from the following: 
• Participant and/or the Legal Representative; 
• Primary Care Physician who oversees the participant’s home program; 
• Primary Caregiver (i.e., parent, spouse, or family member); 
• All providers of HCBS Waiver services (i.e., the HHA, Waiver Personal Care 

Services Providers, INPs, Professional Corporations, and Case Managers); and,  
• All INPs, for participants only receiving Medi-Cal EPSDT INP services. 
 
Keep the original, make a copy, and return the copy by mail, to the address selected 
below: 
 

 Department of Health Care Services  Department of Health Care Services          
 In-Home Operations Branch   In-Home Operations Branch  
 1501 Capitol Avenue, MS 4502   311 South Spring Street, Suite 313 
 P.O. Box 997437     Los Angeles, CA 90013-1211 
 Sacramento, CA 95899-7437    
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